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PART I: Introduction 
 

The DoStudio Encoder (DSE) is a high-quality, easy-to-use solution for encoding MPEG-

4 AVC encoder for Blu-ray and MPEG-4 MVC files for Blu-ray 3D (BD3D).    

 

DSE is verified for use with the following formats: 

 QuickTime files in the following codecs : 

o ProRes422, Prores422 HQ 

o DNxHD 

o Uncompressed 10-bit (AJA, Blackmagic) 

o Uncompressed 8-bit (AJA) 

o XDCAM HD 

 Uncompressed AVI 

 YUV (UYVY colorspace) 

 

The DoStudio Encoder is a single, stand-alone application that can be installed on any PC 

workstation, or Intel-based Mac running Windows in Bootcamp.  DSE is compatible with 

Windows XP, Vista, and Windows 7.  It is compatible with 32-bit and 64-bit operating 

systems. 

 

How the DSE 2D/3D licensing works 

When you purchase the basic AVC encoding license for DSE, you will only be able to 

add 2D segments to your batch list.  2D segments accept a single input file and output a 

single AVC file. 

 

When you purchase the MVC encoding license for DSE, you will have the option to add 

either a 2D or a 3D segment to your batch list.  3D segments accept two input streams 

(one for the left eye and one for the right eye). 
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What the DoStudio Encoder Does: 

 

 It transcodes input files into Blu-ray compliant MVC files for Blu-ray 3D 

 It transcodes input files into Blu-ray compliant AVC files for Blu-ray 

 It displays your source QuickTime file in the Encoder interface and lets you add 

chapter marks visually 

 It allows you to add multiple source files and batch encode them 

 It is a 2-pass encoder 

 

What the DoStudio Encoder Does Not Do: 

 It does not convert frame rates and frame sizes  – your source files must be in a 

valid Blu-ray frame size and frame rate 

 It does not concatenate multiple source video files into a single elementary stream 

 It does not allow segment re-encoding 

 It does not include filtering or other image enhancements during the encoding 

process 
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PART II: Important Blu-ray Spec information 
 

This section provides important technical details about valid frame sizes, frame rates, and 

codecs for Blu-ray and Blu-ray 3D.  Most importantly, it describes the valid 

combinations of these various elements. 
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SECTION 1: Primary Video streams for Standard (2D) Blu-ray 
Disc 

Valid Video Sizes and Frame Rates for Primary Video 

If you are making the transition from DVD authoring to Blu-ray authoring, you will find 

that Blu-ray offers quite a few new frame sizes and frame rates. 

 

Whereas DVD only had two possible video formats: NTSC (720x480 29.97i) or PAL 

(720x576 50i), the Blu-ray Disc specification includes the following frame sizes and 

frame rates for primary video streams: 

 

1920x1080 29.97i, 25i, 23.98p, 24p 

1440x1080 29.97i, 25i, 23.98p, 24p 

1280x720 59.94p, 50p, 23.98p, 24p 

720x480 29.97i  (4x3 and 16x9) 

720x576 25i (4x3 and 16x9) 

DoStudio Encoder Video Sizes and Frame Rates for Primary Video 

The DoStudio Encoder accepts all valid Blu-ray sizes and frame rates for Primary video 

expect for the 1440x1080 frame size.  This frame size is not widely used in professional 

production. 

 

The following chart describes the frame sizes and resolutions that are supported by DSE: 

 
Horizontal 
size of frame 
[pixels] 

Vertical size 
of frame 
[pixels] 
 

frame rate 
[Hz] 
 

Progressive/ 
Interlace 

 

Aspect 
Ratio 

 

1920 1080 29.97 interlace 16:9 
 

25 interlace 

23.976 progressive 

24 progressive 

1280 720 59.94 progressive 16:9 

50 progressive 

23.976 progressive 

24  progressive 

720 480 29.97 interlace 4:3 or 16:9 

720 576 25 interlace 4:3 or 16:9 
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SECTION 2: Secondary Video Streams for Standard (2D) Blu-ray 
Disc 

 

Secondary video streams are used for the Picture-in-Picture feature of Blu-ray Disc.  The 

Secondary video track runs in sync with the primary video track and can be viewed in a 

picture-in-picture window.  The visibility of the secondary video track can be controlled 

by the viewer with their remote control or menu option, or the Blu-ray author can 

program the disc to make the secondary video track visible at specific times.  

 

The DoStudio Encoder creates MPEG-4 AVC elementary streams for both primary and 

secondary video.  The Blu-ray Spec allows the following combination of codecs for 

Primary and Secondary video: 
 

Primary video 
Streams 

Secondary Video Streams 

MPEG-2 MPEG-4 AVC VC-1 

MPEG-2 allowed allowed allowed 

MPEG-4 AVC prohibited allowed prohibited 

VC-1 prohibited prohibited allowed 

 

There are some important bit-rate considerations that the Blu-ray author must know when 

making a disc with Secondary video for Picture-in-Picture features.   

 

1. The Blu-ray spec defines the total video bit-rate value of Primary video and 

Secondary video streams (including subtitles) must be less than or equal to 40 

Mbps.  In practice, it is best to keep your overall bit rate under 38 Mbps due to 

playback inconsistencies among Blu-ray players. 

 

2. The maximum video bit-rate for Secondary video streams must be less than 

or equal to 7.6 Mb/s.  

 

DSE provides Templates for Primary and Secondary video that help you manage the bit-

rate of your encoded video so that it stays within the legal limits of Blu-ray. 
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The next two tables describe the valid combinations of Video Frame Sizes and Frame 

rates for Blu-ray as defined by the Blu-ray specification. 

 
Figure 1 

Primary video streams Secondary video streams 

Horizontal 
size of 
frame 
[pixels] 

Vertical 
size of 
frame 
[pixels] 
 

frame 
rate 
[Hz] 
 

Progressive/ 
Interlace 

 

Horizontal 
size of 
frame 
[pixels] 
 

Vertical 
size of 
frame 
[pixels] 
 

frame 
rate 
[Hz] 
 

Progressive 
/Interlace 

 

1920 or 
1440 

1080 29.97 interlace 720 480 29.97 Interlace 

1920 1080 

1440 1080 

25 interlace 720 576 25 interlace 

1920 1080 

1440 1080 

23.976 progressive 720 480 23.976 progressive 

1920 1080 

1440 1080 

24 progressive 720 480 24 progressive 

1920 1080   

1440 1080   

1280 720 59.94 progressive 720 480 29.97 progressive 

1280 720 59.94 

50 progressive 720 576 25 progressive 

1280 720 50 

23.976 progressive 720 480 23.976 progressive 

1280 720 

24  progressive 720 480 24 progressive 

1280 720 

720 480 29.97 interlace 720 480 29.97 interlace 

720 576 25 interlace 720 576 25 interlace 

 
 

Figure 2 

Primary video streams Secondary video streams 
Horizontal 
size 
of frame 
[pixels] 

Vertical 
size of 
frame 
[pixels] 

Display 
aspect 
ratio 

Horizontal 
size of 
frame 
[pixels] 

Vertical 
size of 
frame 
[pixels] 

Display 
aspect 
ratio 

1920 or 
1440 

1080 16:9 720 480 16:9 or 4:3 
720 576 16:9 or 4:3 

1920 1080 16:9 

1440 1080 16:9 

1280 720 16:9 720 480 16:9 or 4:3 

720 576 16:9 or 4:3 

1280 720 16:9 

720 480 4:3 720 480 4:3 

16:9 720 480 16:9 

720 576 4:3 720 576 4:3 

16:9 720 576 16:9 
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As you can see on the previous page, the Blu-ray specification allows you to create 

secondary video in all of the standard and high definition frame rates and sizes.  

Unfortunately, most Blu-ray players CAN NOT playback a secondary video stream that 

contains high definition video.  Consequently, NetBlender does not recommend using 

HD video in your secondary video tracks. 

Secondary Video frame sizes and frame rates supported by the DoStudio 

Encoder 

 

The DoStudio encoder only supports standard definition video frame sizes for Secondary 

Video streams according to the following table: 

 
Horizontal 
size of frame 
[pixels] 

Vertical size 
of frame 
[pixels] 
 

framerate 
[Hz] 
 

Progressive/ 
Interlace 

 

Aspect 
Ratio 

 

720 480 29.97 interlace 4:3 or 16:9 

720 576 25 interlace 4:3 or 16:9 

 

The following table defines the complete spectrum of combinations of Primary and 

Secondary video streams supported by DSE: 

 
Figure 1 

Primary video streams Secondary video streams 

Horizontal 
size of 
frame 
[pixels] 

Vertical 
size of 
frame 
[pixels] 
 

framerate 
[Hz] 
 

Progressive/ 
Interlace 

 

Horizontal 
size of 
frame 
[pixels] 
 

Vertical 
size of 
frame 
[pixels] 
 

framerate 
[Hz] 
 

Progressive 
/Interlace 

 

1920 1080 29.97 interlace 720 480 29.97 Interlace 

25 interlace 720 576 25 interlace 

23.976 progressive 720 480 23.976 progressive 

24 progressive 720 480 24 progressive 

1280 720 59.94 progressive 720 480 29.97 progressive 

50 progressive 720 576 25 progressive 

23.976 progressive 720 480 23.976 progressive 

24  progressive 720 480 24 progressive 

720 480 29.97 interlace 720 480 29.97 interlace 

720 576 25 interlace 720 576 25 interlace 
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SECTION 3: MVC Encoding for Blu-ray 3D 

Valid Frame Resolutions and Frame Rates for BD3D Video 

The Blu-ray Specification allows a limited combination of frame resolutions and frame 

rates for use with Blu-ray 3D.  The following are the only valid frame resolutions and 

frame rates for BD3D: 

 1920×1080 @ 23.978 fps progressive 

 1280×720 @ 59.94 fps progressive 

 1280×720 @ 50 fps progressive 

Overview of the MVC Format 

MVC stands for Multiview Video Coding.  It is an amendment to the H.264/MPEG-4 

AVC video compression standard developed with joint efforts by MPEG/VCEG that 

enables efficient encoding of sequences captured simultaneously from multiple cameras 

using a single video stream. 

In layman’s terms, the MVC format includes a full-frame 2D AVC stream, called the 

Base View, and a secondary offset file called the Dependent View.  The Base view MVC 

stream is backwards compatible with H.264/AVC, which allows standard 2D Blu-ray 

players and software to decode stereoscopic video streams.  They play the Base View and 

simply ignore the additional information contained in the Dependent View.  The MVC 

format is highly efficient and the Dependent View only adds about 50% extra bit rate to 

the overall stream. 

It is important to note that the Base and Dependent views do not directly correlate to Left 

Eye / Right eye streams.  While the Base view contains the entire full resolution Left Eye 

HD stream (and in theory can be viewed on its own), the Dependent view does not 

contain video information to function as a viewable stream unless paired with the base 

view.  The Dependent view contains offset data that relies on the video stream 

information contained in the Base view. 

Source Files and the encoding process 

3D encoding requires to HD source files, one for each “eye”.  Each source file must be a full-

frame HD stream in one of the three valid resolutions for Blu-ray 3D (see above). 

The encoder interface requires you to select the appropriate stream for each eye.  You make bit 

rate selections and start the encoding process.  Since MVC encoding is really an extension of 

AVC encoding for Blu-ray, the encoding process is essentially the same - apart from the need for 

two input video streams. 

The output of the encoding process is a little different.  The DoStudio MVC encoder outputs two 

files.  It outputs the base view as a single file (”my3dfilm_base.mvc″) and the dependent view as 

a single file (”my3dfilm_dependent.mvc″). You will add both files to the authoring system. 
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DSE also gives you the option to export a single interleaved MVC file.  This file can be played 

back in Arcsoft’s TotalMedia Theatre for proofing the quality of the encode prior to authoring 

your BD3D.  There are also mobile and broadcast applications that use the single interleaved 

MVC file. 

3D sequences 

DSE also provides you with the number of 3D sequences you are using.  If you are going to 

encoding your footage for replication set this number to 32.  This should be default value for all 

new projects.  If you know your 3D Authoring program can use specify a number then use that 

number.  DoStudio Authoring Edition does not specify a number so it is best to use 32 if you are 

using DoStudio authoring Edition.  Contact your authoring tool for more information what 

number should be used. 
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Part III: Preparing your video for import into DSE 
 

In order to successfully encode your video for Blu-ray, your source video must be 

exported as a QuickTime, Uncompressed AVI or YUV file that is in one of the spec-

supported frame sizes and frame rates described in the previous section.  DSE will not 

convert an invalid frame size or frame rate into a valid one during the encoding process. 

 

If you are using QuickTime, your file must be exported in one of the following codecs for 

input into the DoStudio Encoder. 

QuickTime Codecs Supported by DSE: 

 

 AJA 8-bit / 10-bit uncompressed 

 Blackmagic 10-bit uncompressed 

 Apple ProRes / ProRes HQ 

 XDCam HD 

 DNxHD 

   

SECTION 1: Exporting your QT files from Final Cut Pro for DSE 

The following sections describe the process for exporting your source video files from 

Final Cut Pro.  They are listed by the codec type. 

8-bit/10-bit Uncompressed 

The uncompressed formats are native to your Final Cut setup depending on which I/O 

hardware you have installed.  If you have a Kona card or other AJA I/O device, you will 

see the AJA 8-bit and 10-bit uncompressed settings in your Easy Setup.  Likewise, you 

will find Blackmagic versions of these formats if your system has hardware from 

Blackmagic Design. 

 

In order to export a file in these formats, it is recommended that you setup your sequence 

in the 8-bit or 10-bit format of your choosing and edit your video in this sequence.  If you 

have edited your sequence using a different setting, simply copy and paste the elements 

of the sequence into the new 8-bit or 10-bit uncompressed sequence.  Make sure that the 

video is still appearing as it should (check especially for any issue with the scaling of the 

image) and render the sequence if necessary. 

 

To export the file, select Export Movie from the file menu and select Current Settings 

(these will be the uncompressed settings you setup in the Easy Setup). Choose a file name 

and location for your exported file and click “OK.”  The time it takes to export the file 

will vary depending on the size of the file. 
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Apple Prores422 / Prores422 HQ 

The ProRes Codec is native to Final Cut Pro and is supported by the QuickTime player 

on the Mac OS and Windows XP/Vista.   

 

As with the uncompressed formats, it is recommended that you setup your sequence in 

the ProRes format of your choice and edit your video in that sequence. To export the file, 

select Export Movie from the file menu and select Current Settings (these will be the 

ProRes settings you setup in the Easy Setup). Choose a file name and location for your 

exported file and click “OK.”  

XDCAM HD  

XDCAM HD is a codec from Sony that is installed with Final Cut Pro.  It is a variable bit 

rate video format that is used by Sony’s XDCAM line of professional cameras and VTRs.  

The current generation XDCAM HD uses the 4:2:2 profile of the MPEG-2 codec, which 

has double the chroma-resolution of the previous generations. To accommodate the 

chroma-detail, the maximum video-bitrate has been increased to 50 Mbit/s. 

 

As with the uncompressed and Prores formats, it is recommended that you setup your 

sequence in the XDCam HD format and edit your video in that sequence. To export the 

file, select Export Movie from the file menu and select Current Settings (these will be the 

XDCam settings you setup in the Easy Setup). Choose a file name and location for your 

exported file and click “OK”. 

DNxHD 

DNxHD is a codec provided by Avid Technologies that includes a high quality/small file 

size algorithm that is similar in quality and performance to Apple Prores.  This codec is 

native to Avid editing applications but is not native to Final Cut.  However, Avid 

provides the codec for installation on a Mac free of charge.  The codec can be 

downloaded here:  http://avidtechnology.custhelp.com/cgi-

bin/avidtechnology.cfg/php/enduser/std_adp.php?p_faqid=71356 

 

Since DNxHD is not native to Final Cut, you must export your files using QuickTime 

Conversion in order to export a file using the DNxHD codec.  It is recommended that you 

setup your sequence in either the 10-bit uncompressed format, or the Apple ProRes or 

ProRes HQ format and edit your video in that sequence.  When your video is ready for 

exporting, select Export Move>Using QuickTime Conversion from the File menu.  Select 

DNxHD from the format selection list.   

http://avidtechnology.custhelp.com/cgi-bin/avidtechnology.cfg/php/enduser/std_adp.php?p_faqid=71356
http://avidtechnology.custhelp.com/cgi-bin/avidtechnology.cfg/php/enduser/std_adp.php?p_faqid=71356


12 

 

 

SECTION 2: Preparing your Windows environment for 
QuickTime Playback 

 

In order to import QuickTime files from Final Cut Pro into the DoStudio Encoder, you 

must be able to play the QuickTime files on your Windows workstation using 

QuickTime.  Depending on which codec you used, you may need to download and install 

the codec prior to attempting to import the QuickTime file into the DoStudio Encoder. 

 

The following list describes where you can find the necessary codecs: 

 

AJA 8-bit / 10-bit 

Uncompressed 

 

http://www.aja.com/products/software/ 

Blackmagic  10-bit / 

Uncompressed 

 

Install the AJA software above 

 

Apple Prores /  

Prores HQ 

 

Included with your QuickTime installation.   

DNxHD http://avidtechnology.custhelp.com/cgi-

bin/avidtechnology.cfg/php/enduser/std_adp.php?p_faqid=71356 

XDCam HD www.calibratedsoftware.com - $79 decoder for windows 

 

 

Remember, if you can’t play your source QuickTime file in the QuickTime 

player on your Windows workstation, it will not import successfully into the 

DoStudio Encoder.  It is very important that you setup your Windows environment 

to playback the QuickTime source files prior to attempting to encode your video. 
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SECTION 3: Exporting Chapter Markers from Final Cut Pro 

You can mark your chapter points in your Final Cut Pro timeline and export them using 

Apple’s Final Cut pro XML.  DSE can import the chapter markers and force an I-frame 

to be created at the location of the chapters.   

Creating Chapter Markers in Final Cut Pro 

Place the play head in your timeline at the location where you would like to create a 

chapter.  Press “M” to add a marker.  Press “M” again to display the Edit Marker dialog 

box: 

 

Click the Add Chapter marker button 

and click OK.  Do this wherever you 

want to create a chapter. 

 

 

 

 

 

 

 

 

 

 

 

Exporting your Chapter Markers Using FCP XML Interchange Format 

The DoStudio Encoder uses the Apple XML Interchange file that you can export from 

Final Cut Pro to import your chapter markers.  To export the file, select the sequence that 

contains your video and your chapter markers, then select File > Export > XML. 

 

 
 

Use the default settings as seen in the screenshot above.   

 

The section “Importing Chapters from your Final Cut Pro Timeline” describes how to 

import the XML file into the DoStudio Encoder. 
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PART IV: Using the DoStudio Encoder 
 

This section describes the basic operation of the DoStudio encoder: 

 

The DSE Interface 

Starting a new project 

Adding a source video file 

Adding Chapter Markers 

Encoding templates 

Submitting your project to the batch 

Exporting LPCM Audio from your source QuickTime File 

Using the DoStudio QuickTime Converter 
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The DoStudio Encoder Interface 

The DoStudio encoder is project-based.  To add source video for encoding, you create 

encoding segments, apply a template to your segments, then submit the entire project to 

the batch encoder.   

 

The DoStudio Encoder allows you to play back your source Quicktime file in the Control 

Panel and mark chapter points if desired. 

 

Templates are applied via drag-and-drop.  Once applied, you can adjust the parameters 

for each individual encoding segment. 

 

 
 

 

By default, your project includes one Encoding 

Segment with nodes for Primary and Secondary Video.  

If your encoding project includes multiple source 

videos, you will add additional Encoding Segments to 

your tree and select source videos for each title. 
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Start a new project 

To begin, create a new project or open an existing project.  Your project file is called 

yourprojectname.dsEp.  You may save your project file in any convenient location on 

your workstation EXCEPT FOR YOUR WORKSTATION’S DESKTOP.   

Setting the Output Folder and Notification settings 

When you start a new project, by default you see the project output folder and 

notification settings in the control panel.  (You can click the project name at the top of the 

Title list to display these settings at any time).   

 

 
 

Project Settings 

You can set the output folder to any local or network accessible folder.  This is where 

your encoded video files will be created. 

 

Notification Settings 

The DoStudio Encoder offers two methods of setting up status notifications during an 

encode: Email and Twitter.  Enter your account settings for either or both of these 

notification options in the control panel.  Your account settings will be saved on your 

workstation so they will appear when you start a new project.  The settings are not saved 

in your project file so you can share your encoding project without sharing your private 

email and Twitter settings. 

 

You can setup which notifications to receive by using the combo boxes.  You can choose 

to receive a notification when an error occurs, when the encoding starts and ends and you 

can receive a status update at a regular interval. 
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Adding Source video files 

 

Each Encoding Segment in your Segments window contains a node for Primary 

Audio/Video and Secondary Audio/Video.  You will add your source video file to the 

node that corresponds to the type of video you are encoding.  In most cases your video 

will be a Primary Video stream.  You will only use the Secondary video stream if you are 

planning to use the Picture-in-Picture capabilities of standard (2D) Blu-ray. 

 

For 3D encoding, you will always create a Primary Video stream.  There is no 

Secondary (PiP) stream in 3D.   
 

You can add 2D and 3D segments to the same encoding project and batch encode them at 

the same time.  It is not necessary to split your 2D and 3D encoding into separate 

projects. 
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Adding 2D Source Video files 

 

 

Right-click on the Primary Audio/Video 

node to display the context menu.  Select 

“Add Primary Video” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You are prompted to select a source 

video stream.  Navigate to your source 

file and select it.   

 

 

 

 

 

 

 

 

 

 

 

You will now see your 2D source video 

file listed in the Segment tree under the 

Primary Audio/Video node. 

 

The Highest Quality template is applied 

to your segment by default.   
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To add additional source video files to your project, you need to add additional Encoding 

Segments to your Segment tree.   

 

To do this, right-click on the name of 

your project at the top of the Segment 

window (in the screenshot to the left, 

the name of the project is “3D Encode” 

and select “Add a Segment” from the 

context menu.   

 

 

 

 

 

You can add as many Segments as your project requires. Keep in mind that you can add 

both 2D and 3D segments to the same encoding project. 

 

The checkbox indicates that you would like to encode this video when you submit the 

batch for encoding.  You can uncheck the box to exclude the file from the batch.   

 

The Control panel displays your source video’s properties and a playback window to 

view your source video and set chapter marks.   
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If you have selected a Source Video File that is not a Blu-ray compliant frame 

size or resolution you will be notified in a pop-up window that your video is 

not acceptable for input into the DoStudio Encoder.  Please refer to Part II: Section 

1: Valid Video Sizes and Frame Rates for Primary Video for information about 

valid frame sizes and frame rates for Blu-ray Disc. 

 

 

 

Adding a Source Video file for Secondary Video 

The process for adding a source video file for Secondary video is the same as the process 

for Primary video.  The only difference is that the DoStudio encoder will only accept 

standard-definition resolution video files for Secondary video.  Please refer to PART II: 

Section 2: Secondary Video Streams for more information about valid Secondary video 

formats. 
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Adding 3D Source Video files 

 

Right-click on the Primary Audio/Video node to display the context menu.  Select “Add 

3D Primary Video” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You are prompted to select the Left Eye 

source video stream first.  Navigate to your 

source file for the Left Eye and select it.  

Next, you are prompted to select the source 

video stream for the Right Eye.   

 

 

 

 

 

 

 

 

 

You will now see your 3D source video 

file listed in the Segment tree under the 

Primary Audio/Video node. 

 

You will only see the Left Eye stream 

listed in the tree.  

 

The Highest Quality template is applied to 

your segment by default.   
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To add additional source video files to your project, you need to add additional Encoding 

Segments to your Segment tree.   

 

To do this, right-click on the 

name of your project at the top of 

the Segment window (in the 

screenshot above, the name of 

the project is “3D Encode” and 

select “Add a Segment” from the 

context menu.   

 

 

 

 

 

You can add as many Segments as your project requires.  

 

The checkbox indicates that you would like to encode this video when you submit the 

batch for encoding.  You can uncheck the box to exclude the file from the batch.   

 

The Control panel displays your source video’s properties and a playback window to 

view your source video and set chapter marks.   

 

You can select which source file to view using the Left/Right selection box found in the 

Control Panel. 
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Adding Chapter Markers to your video 

 

Adding chapter markers is useful because DSE will create an I-Frame at the chapter 

markers which will guarantee frame accuracy for the chapter when you author your disc 

in DoStudio.  You can add chapter markers to your video in two ways: 

 

Add Chapters while viewing the video 

Use the play controls under the video window to play, pause, fast forward, rewind, and 

step frame-by-frame forward or backwards through your video.  You can also use the 

scrub bar to quickly shuttle through your video. 

 

 
Play controls 

 

Pause the video at the frame where you would like to add a chapter marker and press the 

“Add Chapter” button.  You will see a chapter appear in the Chapters List to the left of 

the video. 

 

If you are encoding 3D video, you need only view one of your streams and mark chapter 

points for it. 

 

Add Chapters manually by entering timecode 

You can also right-click in the Chapters List to display the context menu.  Select “Add a 

Chapter” to add a blank chapter to the list. Select the chapter and enter the timecode 

manually in the timecode window at the bottom of the Chapters List.  
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Importing Chapters from your Final Cut Pro timeline 

 

To import the Chapter Markers you created in Final Cut Pro and exported via Final Cut 

Pro XML, right-click on the word “Chapters” at the top of the Chapters list to reveal the 

context menu. 

 

 
 

Select “Import FCP Chapters” and select the Final Cut Pro XML file using the dialogue 

box.  You will see the chapter markers you created in your Final Cut sequence appear in 

your chapters list. 
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Encoding Templates 

How your source video is encoded is determined by several encoding settings that are 

contained in templates.  You must apply a template to your source video in order to 

encode it.   

 

The process for applying a template is the same for 2D AVC encoding and 3D MVC 

encoding. 

 

For 3D MVC encoding, you will only use the Primary Video Templates.  There is no 

Secondary Video track on a 3D Blu-ray Disc. 

Primary Video Templates 

Primary Video templates define your encoding parameters for primary video. The 

DoStudio Encoder provides the following Primary Video Templates by default: 

 

 Highest Quality – 90 minutes on a BD25, no Secondary video and no high-

bandwidth audio.  (VBR: Target: 35 mb/s, Max: 38 mb/s) 

 

 Feature Video – 120 minutes on a BD25, no Secondary video and space for 

LPCM or other high-bandwidth audio (VBR: Target: 25 mb/s, Max: 35 mb/s) 

 

 Bonus Video – Medium quality video: 180 minutes on a BD25 (VBR: Target 18 

mb/s, Max: 30 mb/s) 

Secondary Video Templates 

Secondary Video templates define your encoding parameters for Secondary video.  The 

Blu-ray spec limits the bit-rate of Secondary video to 7.6 mb/s, so your Secondary video 

template will not allow you to exceed the legal limits for Blu-ray. 

 

The DoStudio Encoder provides the following Secondary Video Templates by default: 

 

 Single PiP track – no Secondary audio, (CBR: Target: 7.0 mb/s) 

 

 Single PiP track – Secondary Audio (CBR: Target: 6 mb/s) 

 

 2 PiP tracks – no Secondary audio (CBR: Target: 3.6 mb/s) 

 

 2 PiP tracks – Secondary Audio (CBR: Target: 3 mb/s) 
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Apply an Encoding Template 

 

To apply an Encoding Template, 

simply drag the desired template 

from the template window at the 

bottom of the screen on to your 

source video file contained in the 

Segments list.   

 

 

 

 

 

 

 

You will see the template listed 

in the Segments list underneath 

the source file it is applied to.  

Click on the template to see its 

properties in the control panel. 

 

 

 

 

 

 

 

You can edit the encoding parameters for a specific clip after you have applied the 

template. 
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Encoding Parameters 

 

Encoding Mode 

You can select either Constant Bit Rate (CBR) or Variable Bit Rate (VBR). 

Number of Passes 

You can select single or 2-pass mode.  In 2-pass mode, the encoder performs an analysis 

pass, and then encodes your video in a second pass.  In single pass mode, the analysis is 

performed concurrently with the encoding process. 

Target Bit Rate 

For CBR encodes, use the slider bar to set a value for your desired bit rate.  Your video 

will be encoded at this bit rate throughout the entire clip.   

 

For VBR, use the slider bar to set a value for the average bit rate.  You will set the 

Maximum (peak) bit rate for your VBR encode in the next field.  

Max Bit Rate 

For VBR encodes, set the maximum bit rate for your encode in the available box.  Keep 

in mind that the maximum recommended bit rate for Blu-ray video is 38 mb/s. 
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Bit Rate Considerations for Blu-ray Disc 

The maximum video bit rate allowed for Blu-ray is 40 Mbps, but in practice it is best not 

to exceed 38 Mbps due to playback performance issues on some Blu-ray players when 

your video does in fact approach the 40 Mbps rate.  The DoStudio Encoder limits you to 

38 Mbps in order to maximize playback compatibility. 

 

In practice, you should be conservative when determining how high of a bit rate to allow 

for. Trying to squeeze out the highest possible bit rate for your project can lead to player 

compatibility and disc space issues. If your project calls for multiple audio tracks, or if 

you plan to use LPCM audio, DTS-HD Master Audio or Dolby TrueHD, you will need to 

limit the video data rate so as not to exceed the overall bit rate allowed by Blu-ray.   A 

general recommendation is to not exceed 43 Mbps for your combined video and audio bit 

rate. 

Bit rate Considerations for Blu-ray 3D 

When you encode a 3D MVC file, you select the target and max bit rate for the base view 

stream only.  The bit rate and corresponding file size of the dependent view file is relative 

to the bit rate of the base view and cannot be manually controlled.  The dependent view is 

not actually a complete video stream.  Rather it contains offset information and video 

data that can only be displayed when combined with the base view.  The overall bitrate of 

the combined MVC files is approximately 50% higher than the base view file by itself. 

Custom Templates 

To create your own custom template, you can duplicate and existing template and edit its 

encoding parameters or you can add a new template from scratch. 

 

To add a new template, right click in the Template window and select Add Template 

from the context menu. Select the new template in the template window to display the 

encoding parameters in the control panel.  Give the template a name and enter your 

desired parameters and click save.  You can update the parameters in your template at 

any time. 

 

To duplicate a template, right-click on the template in the Template window and select 

“Duplicate Template” from the context menu.  You can rename the new template and 

adjust its encoding parameters in the control panel. 

 

You can also import a template that has been created by another user.  Right-click in the 

Template Window and select “Import Template”. 
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Submitting your encoding Project to the Batch 

 

When you are ready to encode your video, click the “encode” button in the toolbar.  This 

will open the batch encode 

window and submit your project 

to the batch. 

 

 

 

 

 

 

Your project will begin the 

encoding process immediately.  All of the video streams in your project will appear in the 

Batch Encoding window.  A progress bar indicates the encoding status of each video 

stream. 

 

 
 

You can stop the encoding process by clicking the red “Stop Encoding” button at the 

bottom of the screen.  You can stop encoding one stream while continuing to encode the 

others in your batch by de-selecting the stream’s checkbox next to the words “Encoding 

the Stream.” 
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Once you have stopped an encode, you need to re-submit the project to the batch to start 

the process again. 

Encoding Status Window 

While your video is encoding, a real-time log of the encoder’s activity is displayed in the 

Encoding Status Window.  You can monitor the progress of your encoding job and view 

error messages in this window. 

 

 
 

You can select and copy the text in the Encoding Status Window by right-clicking to 

reveal a context menu. 



31 

 

 

Batch encoding multiple projects simultaneously 

 

To submit several projects to the batch simultaneously, open the Batch window by 

selecting it from the Window menu. 

 

 
 

 

Right-click in the Batch Encoding Window 

and select “Add Project” to add your 

project to the batch.  You can add multiple 

encoding projects to the batch list. 

 

 

 

 

 

 

 

 

 

Click the “Start Encoding” button to submit the batch and the 

encoding process will begin.  You will see progress bars for 

each of the source videos. 
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Exporting LPCM Audio from your QuickTime File 

 

If your QuickTime file has embedded audio, you can export the audio to an 

uncompressed LPCM wave file.  This LPCM file can be imported into DoStudio 

Authoring, or it can be imported into another audio application to transcode it into a Blu-

ray compliant Dolby or DTS stream. 

 

 
 

To export the LPCM wav file simply click the “Export Wav File” button found in the 

Control panel when you select your video stream.  In the Export Wav File dialogue box, 

choose the folder where you would like to save the file and click “Save”. 
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Using the DoStudio QuickTime Converter 

 

DSE includes a QuickTime Converter that lets you transcode your Primary or Secondary 

Audio/Video streams to other QuickTime formats such as .m4v for iPhone. 

 

 
 

 

To use the QuickTime Converter, right-click on the source file for your Primary or 

Secondary Audio/Video and select “Convert QuickTime File” from the context menu. 
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Choose the destination folder for your converted QuickTime file and what type of export 

you would like to perform.  All of the standard QuickTime conversion formats are 

supported. 
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Part V: Troubleshooting 

 

The following guide will help you understand you how 3D MVC files were encoded and 

how to understand what the errors are if you run into issues.  

Understanding the Encode Specific Log files 

Setting up your output folder will automatically create a log folder under the output 

folder.  Inside this folder are two log files per AVC/MVC file to encode.   The two log 

files are: 

 

    1. sourcefilename_SeverLog.log 

    2. sourcefilename_DSWLog.log 

 

The sourcefilename _ServerLog file contains the name of your source file followed by 

_ServerLog.log.  This log file contains all the core information about the encoded file. 

 This should be the first file to review if something goes wrong.  

 

The sourcefilename DSWLog.log file contains the name of your source file followed by 

_DSWLog.log.  This log file contains information that will be used to make sure the 

communication between the DSE Encoder Server and the DSE UI are ok. 

 

The System.log file 
The System.log file reviews the QuickTime installation and other details about your 

system that the encoder uses to as resources.  This file is created once per batch encode. 

 

The DSE Log file 
The DSE Log file is used only by NetBlender and is found in My Documents -> 

NetBlender -> DSE -> log.txt 
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Trouble Shooting Steps 

If the encode fails instantly… 

 

1. Make sure you can play the video using Apple's QuickTime player. 

2. Make sure the source files are in one of the acceptable sizes and frame rates for Blu-

ray: 

 

For AVC (2D Blu-ray): 

 
Horizontal 
size of frame 
[pixels] 

Vertical size 
of frame 
[pixels] 
 

frame rate 
[Hz] 
 

Progressive/ 
Interlace 

 

Aspect 
Ratio 

 

1920 1080 29.97 interlace 16:9 
 

25 interlace 

23.976 progressive 

24 progressive 

1280 720 59.94 progressive 16:9 

50 progressive 

23.976 progressive 

24  progressive 

720 480 29.97 interlace 4:3 or 16:9 

720 576 25 interlace 4:3 or 16:9 

 

 

For MVC (3D Blu-ray): 

 
Horizontal 
size of frame 
[pixels] 

Vertical size 
of frame 
[pixels] 
 

frame rate 
[Hz] 
 

Progressive/ 
Interlace 

 

Aspect 
Ratio 

 

1920 1080 23.976 progressive 16:9 

1280 720 59.94 progressive 16:9 

1280 720 50 progressive 16:9 

 

 

3. Send All 3 types of log files to NetBlender at sales@netblender.com  
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If the encode fails after more than 1% is completed… 

1. Make sure there is enough disc space. 

2. Make sure there isn't any anti-virus software that will be scanning when the encoder is 

writing out the encoded files. 

3. Send All 3 types of log files to NetBlender at sales@netblender.com  

 

The first encode works but the second one fails… 

 

1. Send All 3 types of log files to NetBlender at sales@netblender.com  

2. Close DSE 

3. Open DSE and then try to encode the second stream. 

4. If this still fails let us know. 

The video does not look ok… 

 

1. Send All 3 types of log files to NetBlender at sales@netblender.com.  

2. Indicate the specific visual issue you are seeing in your email to us. 

 

Click on the Batch Encode does nothing… 

 

1. Open the Batch Window if not already open then try again. 

2. If this still fails. 

3. Send All 3 types of log files to NetBlender at sales@netblender.com.  

 


